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About this Manual

Overview

The manual describes the Touch Panel TP 612C CAN from VIPA. Here
you find detailed descriptions of the Touch Panel beside a product
overview. Here you get information about structure, project engineering
and operation of the Touch panels from VIPA.

Chapter 1: Hardware description

During this chapter you get hints for deployment of the Touch Panel
TP 612C CAN from VIPA.

Besides of a description of the single components of the Touch Panel, you
will also find the dimensions that are required for the installation. The
chapter closes with the technical data.

Chapter 2: Deployment Touch Panel
This chapter deals with the employment of the Touch Panel.

At the start of the chapter you receive information about the assembly and
the connection of the Touch Panel. The main part of the chapter introduces
Windows® CE and the various communication options offered by the Touch
Panel.

Chapter 3: Installation guidelines

This chapter helps you to install an interference-free automation system.
First, possible interference sources and their interaction mechanisms are
shown, followed by basic rules for guaranteeing EMC. Afterwards you'll find
information about assembly and cabling following EMC rules.

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 1
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Manual VIPA System HMI

Objective and

This manual describes the Touch Panels from VIPA. The manual consists

contents of chapters. Every chapter provides the description of one specific topic.
It describes the installation, project engineering, usage and the technical
data.
This manual is part of the documentation package
with order number VIPA HB160E_TP and relevant for:
Product Order number as of state:
HW oS
TP 612C CAN VIPA 612-3B2J0 01 Windows® CE V. 5.0
Guide to the This manual provides the following guides:
document « An overall table of contents at the beginning of the manual
* An overview of the topics for every chapter
* Anindex at the end of the manual.
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Description [Button] Buttons are put in brackets e.g. [NEXT] or [OK].
conventions -
[Key] Key entry are put in brackets e.g. [STRG]+[A].
Di spl ay Display outputs are illustrated as Courier e.g.
out put \ fl ashdi sk>
Keyboard Keyboard entries are illustrated as Couri er bol d e.g.
entry \flashdisk> Dir
Terms Menus, Display elements, terms are italics.
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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Safety information

Applications The Touch Panels are constructed and manufactured for:
conforming with « VIPA CPUs 11x, 21x, 31x, 51x and S7-300/400 from Siemens
specifications A

« communication and process control

» general control and automation applications

 industrial applications

» operation within the environmental conditions specified in the technical
data

« installation into a cubicle

Danger!
This device is not certified for applications in
* in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the
* project design department
 installation department
e commissioning
e operation

The following conditions must be met before using or commissioning
the components described in this manual:

» Modification to the process control system should only be carried out
when the system has been disconnected from power!

* Installation and modifications only by properly trained personnel

» The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 3
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Chapter 1 Hardware description

Chapter 1

Overview

Content

Hardware description

During this chapter you get hints for deployment of the Touch Panel
TP 612C CAN from VIPA.

Besides of a description of the single components of the Touch Panel, you
will also find the dimensions that are required for the installation. The
chapter closes with the technical data.
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Safety information for Users

Handling of
electrostatic
sensitive modules

Shipping of
electrostatic
sensitive modules

Measurements
and alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges:

The symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable. Modules that have been damaged by electrostatic discharges
may fail after a temperature change, mechanical shock or changes in the
electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules have to be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:

* Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2
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Properties
General The Touch Panel allows you to visualize and alter operating states and
recent process values of a connected PLC.
/
[o
q
Q
<
&)
:
IS
TP 612C CAN The VIPA Touch Panel is a compact and modular embedded PC based on
612-3B2J0 Windows® CE. Besides of the extensive Windows® CE functions the Touch
Panel offers varied communication possibilities. Here the Touch Panel can
simply be configured, controlled and remoted. By including a selectable
HMI/SCADA runtime the Touch Panel is particularly suitable for monitoring
and controlling of process cycles.
« Microsoft Windows® CE V. 5.0 (full version as option)
- Different HMI/SCADA-Runtime selectable
» B800MHz pulse frequency
«  Work memory 128Mbyte
about 1800Mbyte memory for user data on Board
» CF-Card Il and MMC/SD card slot
» Horizontal and vertical display selectable in 90° steps
* RS232, RS422/485, CAN, Ethernet,
USB-A and USB-B interfaces on board
« Robust aluminium die casting case
» Display resolution 800 x 600 / 600 x 800 (64k colors)
- Battery backed clock
+ Resistive touch screen
- Easy mounting via integrated pivoted lever
» Protection class IP65 (frontal)
Order data
Type Order number Description

TP 612C CAN VIPA 612-3B2J0 |12.1" SVGA TFT color, CAN interface, RS232,
RS422/485, 2xUSB-A, USB-B, 2xEthernet RJ45 (switch)

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 1-3



Chapter 1 Hardware description Manual VIPA HMI

Structure
Front view
e [1] Slot for storage medium
c (CF, SD/MMC)
© [2] Connection for interfaces and
1 o power supply
ﬁ [3] Display with touch sensitive area
5 (touch screen)
9
|_
3
2
Side view ——

T [1] Compact Flash
[2] MMC/SD
17
,—
Note!

Please regard that the Touch Panel always has to be supplied with external
voltage!

1-4 HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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Chapter 1 Hardware description

Bottom view
(Interfaces)

TP 612C CAN
12.1"

612-3B2J0

Components

i

y

[1]
[2]
[3]
[4]
[5]
(6], [7]
[8]
[9]

1 2 3 4 5 6

RS422/485 interface COM 2

RS232 interface COM 1

CAN interface

2x "Host"-USB-A interface

"Slave"-USB-B interface

RJ45 jack for Ethernet Communication (switch)
Slot for DC 24V voltage supply

Slot for CF/SD/MMC storage medium

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 1-5
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Components

Memory
management

Work memory

Flash disc

USB storage media

Slot for CF

Slot for SD/MMC

Security flap for
memory cards

The following memory systems are available for every Touch Panel:
* 128Mbyte work memory

» 2Gbyte Flash-Disk (ca. 1800Mbyte for user data)

* USB storage media using "Host"-USB-A interface

» Slot for CF (Type II)

» Slot for MMC/SD

Every Touch Panel has a work memory with a size of 128Mbyte. The work
memory is not buffered and is deleted after shut down. Please regard that
also registry entries are stored in the work memory that are set back to
default settings after the next re-boot. You may save them permanently by
means of the KuK Tools (within consignment).

As internal permanent storage medium every Touch Panel has a flash disc
with a size of 2Gbyte (about 1800Mbyte user data). After the start of
Windows® CE this memory is listed as Flashdisk at My Device.

The connection of USB sticks and USB drives by use of the "Host"-USB-A
interface is supported by the Touch Panel. After connection the storage
media is listed as Hard Disk at My Device.

Here you may plug a CompactFlash” type Il. The card may be plugged
and removed during runtime and is immediately listed as Storage Card at
My Device.

Every CompactFlash” storage module has a pulling edge. Hold the
CompactFlash in the way that the pulling edge points to the left side. Push
the storage module without much power into the slot until the impact. To
remove the card touch it at the pulling edge and pull.

At this slot you may plug storage modules of the type SD or MMC. The
card may be plugged and removed during runtime and is immediately listed
as SDMMC Card at My Device.

Please take care to plug the according card as shown at the backside of
the Touch Panel.

At the left side of the Touch Panel are the card slots for memory cards.
The cards are visibly covered by a security flap and are thus secured from
slipping out.

Please take care to pull the security flap back before plugging or pulling a
memory card like shown in the illustration and put it back again afterwards.

When plugging, the security flap additionally snaps into position above the
plugged memory card.

1-6
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Chapter 1 Hardware description

RS422/485
interface

Connection
RS422/485

CAN interface

» Logical states represented by voltage differences between the 4 cores
» Serial bus connection in 4-wire technology using full duplex mode
« Data communications up to a max. distance of 500m
» Data communication rate up to 115.2kBaud

9pin jack

Pin | RS422/485

RS422

n.c.

n.c.

TxD+ (Line A)

RxD+ (Line A)

M5V

PS5V

n.c.

TxD- (Line B)

OIOINOU| AW N

RxD- (Line B)

Connection RS422 (isolated)

Periphery

TxD+ (A) 3 / \ RxD+
[

TxD- (B) 8 I ‘1 RxD-
) [

RxD+ (A) 4 { ! TxD+
I

RxD- (B) 9 | ‘ TxD-
T T
I I

M5V 5 | l

R §
b

% 6 L

P — § \

Shield \ //

———————— ---e

9pin jack

RS485

Serial bus connection in 2-wire technology using half duplex mode

Connection RS485 (isolated)

Periphery

Pin | Assignment

1 |reserved

CAN low

CAN Ground

reserved

Shield

reserved

CAN high

CAN Ground

Shield ——m——AL——

reserved

OO Nl B WIN

reserved

CAN Ground

Shield

TXD+ (A) 3 r\ RXD+/TXD+
[
TxD- (B) 8 I ‘1 RXD-/TXD-
' [
RXD+ (A) 4 ! |
|
|
RxD- (B) 9 ‘ ‘ J‘
| “ Periphery
M5V 5 | /
R §
\ | RxD+/TxD+
P5V 6 \ |
I L RXD-/TXD-
Shield A
77777777 - — - o
Connection CAN
Master Slave
Shield
) Y 7
CAN high — CAN high
[?1209 " | 120Q ﬂ] 2
CAN low T . CAN low

HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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RS232 interface

Connection RS232

Ethernet
connection

O~NOO_WNE

Interface is compatible to the COM interface of a PC

» Logical signals as voltage levels

» Point-to-point links with serial full-duplex transfer in two-wire technology
up to 15m distance

» Data transfer rate up to 115.2kBaud

9pin plug Connection RS232

Pin |RS232 — ) ) e
1 |CD 0 s ’/ \‘ {,’ \, R%0
2 RxD RXD 2 L L ™D
3 |TxD 1
4 DTR GND i ‘ i ‘ GND
5 |GND AR
6 |DSR T
7 |RTS e / ‘\ /"
8 CTS Shield- — — — — 4— — — - -~ —|- — — — Shield
9 RI

An RJ45 jack provides the interface to the twisted pair cable, required for
Ethernet. The pin assignment of this jack is as follows:

8pin RJ45 jack:

Pin | Signal

1 |Transmit +
2 | Transmit -
3 | Receive +
4 |-

5 |-

6 |Receive -
7 |-

8 |-

1-8
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Chapter 1 Hardware description

"Host"-USB-A

P N W b

"Slave"-USB-B

VIPA USB-B
Programming cable

Power supply

DC 24V
- -
e
nCal

- <+

Using the "Host"-USB-A interface mouse, keyboard, USB stick ore USB
hard discs can be connected.
The pin assignment is as follows:

"Host"-USB-A:
Pin Assignment
1 VCC
2 DM
3 DP
4 GND

For project transfer with Microsoft ActiveSync a programming cable can be
connected using the "Slave"-USB-B interface.
The pin assignment is as follows:

"Slave"-USB-B:
Pin Assignment
1 VCC
2 DM
3 DP
4 GND

The USB-A interface of your PC can be connected to the "Slave"-USB-B
interface of your Touch Panel deploying the USB programming cable.

The USB programming cable is delivered by VIPA with order No.
VIPA 670-0KB10.

The Touch Panel has got an integrated power supply. The power supply
has to be provided with DC 24V (20.4 ... 28.8V). For this you find an
according DC 24V slot at the bottom side.

The power supply is protected against inverse polarity and overcurrent.

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 1-9
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Manual VIPA HMI

Dimensions

Installation
dimensions

12.1"
612-3B2J0

installation width

width

installation hight
hight

installation
depth

For the installation of the Touch Panel in control cabinets and desks the
following dimensions are necessary:

Front panel width 15..6
Installation cutting (W x H) 311 x 249
Front panel (W x H) 325 x 263
Back side (W x H x D) 309 x 247 x 45
Installation depth 45

Dimensions in mm

Note!

The degrees of protection are only guaranteed when the following is

observed:

» Material thickness at the mounting cut-out: 1.5 ... 6mm

» the deviation from the plane for the panel cut-out is <0.5mm. This
condition must be fulfilled for the mounted HMI device

» Permissible surface roughness in the area of the seal: <120um

(friction coefficient 120)

1-10
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Technical Data

TP 612C CAN

Electrical data

VIPA 612-3B2J0

Nominal supply voltage

DC 24V (20.4 ... 28.8V)

ESD/Burst

Acc. IEC 61000-4-2 / IEC 61000-4-4 (up to level 3)

Shock resistance

Acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

Level of noise suppression

Acc. IEC 61000-6-4

mark of conformity and certification

CE

Clock and housing

Processor Xscale 800MHz
Clock Hardware clock, buffered
Housing - protection class Solid aluminium case

- Front IP 65

- Back IP 20

Environment conditions

Mounting position

horizontally/vertically

Operating temperature 0...+50°C

Relative humidity max. 85%

Storing / Transport temperature -20 to +60°C

Display

Size 12.1" (246 x 184.5mm)
Resolution 600 x 800 / 800 x 600
Colors TFT color (64K colors)
MTBF Backlights (25°C) ca. 50000h

Peripherals

Touch screen resistive

external Mouse, Keyboard USB

Memory

Type 2GB Flash / 128Mbyte RAM
Available memory for user data about 1800Mbyte

CF Card Slot Type Il yes

SD/MMC Push-Push-Slot yes

Interfaces

CAN yes

serial RS232 COM 1

serial RS422/485 isolated COM 2
USB 2xUSB-A, 1xUSB-B
Ethernet 2x10/100 RJ45 (switch)

Electrical Data

Nominal supply voltage

DC 24V (20.4 ... 28.8V)

Nominal current 0.7A
Box
Fixing via 9 integrated pivoted lever

Dimensions and weight

Front (WxH)

325 x 263mm

Back (WxHxD)

309 x 247 x 45mm

Integration cut-out (WxH)

311 x 249mm (Front panel width: 1.5

... 6mm)

Weight

3674g

HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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Chapter 2 Deployment Touch Panel

Chapter 2

Overview

Content

Deployment Touch Panel

This chapter deals with the employment of the Touch Panel.

At the start of the chapter you receive information about the assembly and
the connection of the Touch Panel. The main part of the chapter introduces
Windows® CE and the various communication options offered by the Touch
Panel.

Topic Page
Chapter 2 Deployment Touch Panel .............cccoovvviiiiii i, 2-1
INSTAIALION ... 2-2
(070] 191015510 o1 T T 2-4
Connection to @ PLC SYStEM .......covviiiiiiiiiieeeeeeeeeee e 2-11
Operating system WIindows® CE ...........cceoieveeieeeeeeeeeeeeeee e, 2-12
Communication via ACHIVESYNC .......ccoovveiiiiiiiieeeeeeeeee e 2-17
INtEGrated SEIVEN ..o e e e e e eeeees 2-20
Access 10 the NEtWOIK rESOUICES. .........vvviiiiiiiiiiiiiiiiieieeeeeeeeeee e 2-27
Integration to WLAN NetwOork ..........uoiiiiiiiiiiii e 2-29
FIrmware UPAate ..........cooovviiiiiiiii e e e e e eaaens 2-31
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Installation

Overview

Installation cutting

Installation

The Touch Panel is suitable for the installation in operating tables and
control cabinet fronts. The installation happens via the backside. The
Touch Panel is provided with a patented integrated fixing technique that
allows an easy connection with a simple screwdriver.

Due to the fact that the Touch Panel has a plug connector for bus
connection and voltage supply, a fast and easy device change is possible.

For the installation into a operating tableau and control cabinet fronts, the
Touch Panel requires the following front plate cutting:

W
H
Touch Panel W x Hin mm
612-3B2J0 311 x 249

The fixing technique is integrated in the casing of the Touch Panel and
accessible via the backside.

For the installation, a small slit screwdriver is required. Push the operator
panel [3] from the front side into the front panel cutting [1] until it touches
the panel with the seal [2]. Now bolt the lever [5] clockwise with the
screwdriver [4] until it rotates to the outside. Further screwing bolts the
lever to the front panel until it holds this to the control cabinet front.

P 2
1

2-2
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Connect
power supply

@

<—

EJ

For the cabling of the DC 24V power supply green plugs with CageClamp
technology are deployed. The spring-clip connector technology simplifies
the wiring requirements for signaling and power cables. In contrast to
screw terminal connections, spring-clip wiring is vibration proof.

Here also you may connect wires with a cross-section of 0.08mm? to
2.5mm?®. You can use flexible wires without end case as well as stiff wires.

You fix the conductors to the CageClamps like this:

DC 24V

- . . .
1 Round opening for wires
0@ : 1 oo

F: 5 [2] Locking (orange) for screwdriver
. [3] Test point for 2mm test tip

The picture on the left side shows the cabling step by step from top view.

e For cabling you push the locking vertical to the inside with a suiting
screwdriver and hold the screwdriver in this position.

* Insert the insulation-striped wire into the round opening. You may use
wires with a cross-section from 0.08mm? to 2.5mm®.

e By removing the screwdriver the wire is connected safely with the plug
connector via a spring.

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 2-3
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Commissioning

VIPA Startup

Attention!
» Before commissioning the device must be brought to room temperature.

* At condensation the device must be absolutely dry before connected to
power.

» To avoid overheat during operation the device must not be laid open to
direct sun light.

» After opening the control cabinet or desk, there are parts with possible
dangerous voltage available.

» For all signal connections only screened cables are permitted.

» Signal cables must not be let within the same cable shaft as high
voltage cables.

As soon as the Touch Panel is provided by power supply the Touch Panel

Manager starts with "user area" of the VIPA Startup Manager:
User area
- NG
i} 2 z- 25
e &
i3
art of automation
Advanced On delivery the button [Advanced] is shown at the starting screen. Further
buttons and their properties may be configured in the administrator area
with the button [Settings] or freely programmed by means of an XML editor
at the file startup.xml in the directory StartupMngr > flashdisc.
Startup.xml The file startup.xml may be found at StartupMngr > flashdisc.
By means of an XML editor the Startup Manager may be individually
adapted.
2-4 HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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With clicking to [Advanced] the administrator area is opened. On delivery

VIPA Startup- _
there are the following buttons:

Manager

Administrator area

KuK Tools

Backup

Restore

Normal

Control Panel

Exit

VIS

art of automation

KUK Tools l

Marmal

dn Contral Panel [T
] Con I_ T

=1 g 8.0 i .;:_ I-:::
l . Settings T 1

=H )(| T,
flr‘Jr ‘L_ ..:E-t .
L+

To permanently store changes within the Registry after PowerOFF -
PowerON the program KuK Tools is to be used. The program may be
executed by clicking to the button [KuK Tools]. To permanently store the
registry file click at the button [Store] of "Permanent Registry".

With [Backup] the files of the flash disk and the Registry settings may be
stored.

The backed up files may be restored by [Restore].

With this button you may return to the user area.

With the button [Control Panel] or with Start > Settings > Control Panel the
system settings like brightness and contrast of the display may be preset or
the display may be re-calibrated.

Here the communication interfaces may also be configured.

The VIPA Startup Manager is closed by [Exit] and the system returns to the
Windows® operating system.
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Settings

Main

Buttons may be configured with [Settings]. Here buttons may be added or
removed respectively assigned with programs.

Main | Fixed | Custom | Passward | Copy | Executs ML

Configure program behaviour and menu layouk here

- Program (stored in the reqgistryd

IE RunnnStartup Enable User Interface
- Menu
Background: | |:!
Position
{Hnriznntal: ICenter |:I Yertical: ICenter |T|

Here general settings may be established.

A new background picture may be loaded at "Background ...". With "Font
Color" and "Back Color" the color of the button font and of the button may
be preset. The position of the buttons may be changed by "Position".

Enabling "Run on Startup” with the system start the functions established
at "Settings" are activated.

With disabling "Run on Startup” the Touch Panel starts with the Windows®
operating system. The functions preset at "Settings" are ignored.

With enabling "Enable User Interface” the Touch Panel starts with the
Startup Manager, the listed functions of "Copy" and "Execute" are executed
and the program marked with "Autostart" is executed.

If "Enable User Interface" is disabled, the Touch Panel starts without
Startup Manager but in the background the listed functions of "Copy" and
"Execute" are executed. Then the system return to the Windows® operating
system. A program marked with "Autostart” is not executed.

Note!

To remain the settings permanently, they have to be saved with
KuK-Tools > Save Registry.

2-6
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| Main | Fized | Customn | Password | Copy | Bxecute | 4 [
% Define non-configurable menu ikem names

Menu Itermn:

Avanced voce: [T~

Zontrol Panel
Title: |

Here the buttons are listed, which may not be changed in the user
respectively administrator area.

Custom | Password | Copy | Execute | about | KIE
Dlﬁ Zonfigure menu for Mormal and Advanced mode

Menu Ikem:

Program: |

L]
Parar: I |:|

Here new buttons may be configured and assigned with corresponding
programs.

You may choose "Normal" for the user area or "Advanced" for the
administrator area. With [+] a new button may be added. Designate the
button and click at [...] to assign the button to a program. The button may
be removed with [-].
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Password

Copy

[Main IFi}{ed ICustDm | Password |C|:||:n_.f IE}{ecute L4 I

~— iy Define aor change password for advanced mode

_.j. }g

2ld Password: I

Mew Password; |

E| Shiow Password

The administrator area may be protected by a password. Here you may
enter respectively change the password of the administrator area.

If you click within the user area to the button [Advanced] and a password is
defined, you were prompted to enter the password. If there is no password
defined, the administrator area is opened. On delivery there is no password
preset.

If you have forgot you password by enabling the checkbox "Show
Password" the password may be displayed.

| Main I Fixed [Cuztum IF‘EISSWDFE] | Copy IE}{ecute i o
% Define lisk of files bo copy on starkup

Ikems to copy:

Source | Destination

Here with the startup of the panel files may be copied e.g. from flash disk
to Windows®.

The files to be copied are added by [+]. With [-] the corresponding file is
removed from the list. With [...] the file may be downloaded.

2-8
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Execute

| Fixed | Custom | Password | Copy | Execute | Aoy 4 [»
ﬁ Define lisk of programs ta launch aukomatically an

startup

applications:

Pragram: [\SDMMC CardiMowCEY ..
KUEYRCSYr exe - III' II' II' D

MowCE, exe Pararm: I EI
SwsarwilE. exe
ZEMOMFCE  EXE

I:] Aukoskart

: ]
Delay: SEC,

Here programs may be added, which have to start in the background

during startup e.g. VNC server or transport services.

With enabling the checkbox "Autostart”" the program is always executed on

startup after the preset "Delay time".
On delivery the program of your run time version is preset.

' Fixed | custom | Password | copy | Execute | ahou 4 »
% Define list of programs ko launch automatically an

starbup

fpplications:

CEUploadServer.exe  program: [\SDMMC CardiMovCEL 2. ]
FLUEMYDCSwr exe -
Param: !'"l,SDMMC Card\MCOYPR L_I
SysarviCE.exe
ZEMOMFCE  EXE

E! fukostark

—

Delay: SELC,

HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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About

Control Panel

Configuration
COM2
RS422/485

i CLstom I Passward I Copy l Execute |.ﬂhDUt | [:I I*_

Startup Manager

Yersion: 2.0.0.505

© 2008 VIPA GmbH

Here you may find the current version of the VIPA Startup-Manager.

To configure the COM2 interface on the Touch Panel start via the button
"Control Panel" the tool "Com2 Configuration".

In the opened dialog window you activate the RS485 or the RS422
interface.

Default: RS485

COM2 Configuration m

Enahle
Ooff @48 O422

To remain the settings permanently, they have to be saved with
KuK-Tools > Save Registry.

To activate the changes the Touch Panel has to be restarted after
configuration.

2-10

HB160E - TP - RE_612-3B2J0 - Rev. 10/16



Manual VIPA HMI

Chapter 2 Deployment Touch Panel

Connection to a PLC system

Touch Panel

For the inclusion into your PLC system several HMI/SCADA project-
engineering platforms are at your disposal that has to be installed at an
external PC. Here you may create your project, where appropriate simulate
it and transfer it to the Touch Panel via a connection that you've entered
before. Via the at the Touch Panel pre-installed runtime version of the
HMI/SCADA project engineering platforms your project is run able.

By using the according communication driver, the Touch Panel supports
connecting options to the PLC via field bus and Ethernet.

During the operation your operating device communicates with the
according PLC and reacts to the application courses in the PLC according
to the configured processes. Via dialogs configured before, process values
may be monitored graphically, altered and evaluated.

PC

Runtime

- ftp-Server
- http-Server
- Telnet

- VNC

HMI/SCADA

MMC/SD/CF

Touch Panel

., =

Fieldbus,
Ethernet

MS ActiveSync, ftp, http, Telnet, VNC

PLC
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Operating system Windows® CE

Windows® CE

Windows® CE
Core 5.0

Windows® CE
Professional Plus 5.0

Differences Core- and
Professional-Plus
version

Within the consignment of the Touch Panel is the operating system
Microsoft Windows® CE V. 5.0. It is an OEM licensed English version. The
newly developed standard Windows® CE allows devices that are
communicating with each other to exchange information with Windows®
based devices and to establish connections to the Internet.

Microsoft Windows® CE is a 32bit, open and scalable platform for a
multiplicity of communication and data processing devices. The functions
like multi-tasking and multi-threading are supported by this operating
system.

As default Microsoft Windows® CE Core 5.0 is delivered and optionally
Microsoft Windows® CE Professional Plus 5.0. The version may be found
at a label at the backside of your Touch Panel.

This version is a Windows® operating system reduced to the absolute
essentials with mouse operation (touch screen) that requires only small
hardware resources. Here the 2 icons "My Device" and "Recycle Bin" may
exclusively be found at the Desktop.

The Professional-Plus version is an enhanced Core version. Here among
others some file viewer, an Internet browser and bluetooth support are
integrated. On the desktop besides many icons a mouse pointer is
displayed at the pen position. As soon as the pen is hold at one position
the context menu is displayed.

Features Windows® CE Core 5.0 Professional
Plus 5.0
ftp, http, Telnet and VNC server X X
RAS server - X
ActiveSync file transfer X X
(USB, RS232, Ethernet)
RDP (Remote Desktop Protocol) - X
Internet Explorer 6 - X
Registry Editor X X
WordPad - X
Mouse pointer - X
USB keyboard driver X X
HP printer driver X X
(COM, Ethernet, USB)
Bluetooth USB stick support - X
(Keyboard, mouse, modem, network)
WLAN Support (SD Card, USB-Stick) X X
File viewer for Word, Excel, - X
PowerPoint and PDF
VIPA Startup Manager X X

2-12
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Differences to the
standard Windows
operation

®

Pen entry

Navigation within
the dialog window

Exit Windows®
(shut down)

Please regard that for the deployment of Windows® CE a thorough
knowledge of operating Windows® are assumed. Here are only shown the
differences to a "standard" Windows® operating system.

You're operating the Touch Panel by means of a pencil res. with the finger.
When touching an area at the touch screen this area is recognized and the
program reacts accordingly. The following types of entry are differentiated:

Double click

A double click has to be executed like mouse operation by touching the
area at the screen twice. A double click on an object open res. executes
this.

Drag

By tapping on an object and then dragging you may move the object on the
screen. If no object is selected, a frame is created by the dragging that
selects the touched objects.

Characteristics with Windows® CE Professional Plus V. 5.0

In the Professional Plus version mouse functions are fully supported. As
soon as the touch screen is touched with the pen, a mouse pointer is
shown on the desktop at the pen position.

To show the context menu you can either press the right key of your
mouse connected by USB or hold the pen on one position.

The windows may be moved via the head bar. Here you may also find the
[OK] button to confirm entries and the [X] button for exiting the dialog.

You may not exit Windows®. By switching the power supply off and on
again you may restart Windows®. Before a reboot you should always save
your data res. close all running applications to avoid data loss.

Note!

Please regard that made changes are set back after PowerOFF-PowerON
and are only stored via Save Registry which is to be found at
Start > Programs > KuK Tools.
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Structure
l'u Microsoft d C
P-TE
1 [lcon Via icons on the desktop you gain direct access to the application related to
the icon.
2 | Desktop The desktop is the screen that is shown after login at Windows® CE. It
contains e.g. links to the mostly used applications res. system components.
3 |Task bar The task bar is part of the desktop. When opening an application, a
document or a window, every running object is displayed as button on the
task bar. Via this buttons you may easily change between the open
windows.
Task bar Basically the task bar has the following structure:
|§35tart I|@F‘r0gram Files ||ECDmmand Frompt I |._1LE@ 05:42 |@"@I|
\ |
| |
1 2 3 4 5 6 7 8
1 | Start button This button offers you access to all components of your Touch Panel like
e.g. applications, system settings, file browser etc.
2 | Open For every open application a button is to be found in the task bar. There is
applications no button for minimizing. The switch between the applications happens via
this buttons.
3 | Network As soon as your Touch Panel is connected via Ethernet you may here
connection display the Ethernet address.
If there is no connection via Ethernet, the symbol is displayed crossed out.
4 | Desktop This symbol allows you to switch between 2 desktop directions. The position
direction setting happens in steps of 90° and can be set via double click in a dialog
window.
5 |Keyboard If you've connected a keyboard you may choose the wanted language
layout layout via this button.
6 |Time This area shows the time that you may change via double click.
7 | Show desktop |All windows are minimized and the desktop is shown.
8 | Software This button displays a keyboard at the screen. "Hide Input Panel" hides the
keyboard keyboard again.
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Software keyboard

Software keyboard
Keyboard

Software keyboard
Large KB

Hide keyboard

A

The button allows you to select one of the available software
keyboards. At the moment the following standard keyboards are
implemented:

Normal: At pushed SHIFT key:

CAPla|s|d
Shift| z [= [ ¢
crfai]  JA]

At pushed [a"U] key:

Note!

Please regard that the umlauts 46U may exclusively entered via the
software keyboard Keyboard.

Normal: Meaning:
Home Position 1

Esc| F1| F2| F2 | F4 | FS [ Fa [ F7 | F8 | F9 |F10|F11| F12|Home] eEnd |Frop End End

1/2|3|4|5|e|7|8|9]|0]|-|=]|BS| BSBackspace

Talqlwlelr |ty |ulilolp|[|]1]Y]upt

Ceslals|(d|fl9|h| T [k|1]:i] ] eun |dnl

sie) 2 | x|c|lv | b|nim|.,|.|/flup pasp| 1 <

crl | win | Al ins | cel| It |dn| rt |padn re—

At pushed SHIFT key: Pgup Page 1
pgdn Page |

Esc| F1| F2|F2 | F4 | Fs | F& [ F7 | F8 | F9 |F10{F11| F12||Home] End |Prop ins Insert

~lrTalalsw] ~la =[] T+]es del Delete

| QW[ E(R[T|Y|ul[z[o[p| |1 a0 Tabulator

cesl pls|D|F H| 3] [ e | O

B Caps/Lock

ZXCVBNM > 2 [up| [oow

el | win | Al ins | cel| It |dn| rt |padn

The software keyboard allows you to enter key entries without connecting
an external keyboard. As soon as an entry is required the software
keyboard is automatically shown.

Hide Input Panel hides the keyboard again.

HB160E - TP - RE_612-3B2J0 - Rev. 10/16
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System setting
(Control Panel)

Due to the fact that many components of the Control Panel are concurring
with the system control of Windows®, most of the description is here
dispensed. The description of the control panel components relevant for
operating the Touch Panel is to be found in the following:

Set display

Via Start > Settings > Control Panel > Display the dialog windows for the
display properties opens. Here you may change the settings for the monitor
options.

For example you may adjust the brightness and contrast via the register
Settings.

Calibrate touch screen

If your touch screen does not always react on a double click or recognizes
the position of an entry not precisely, you may call the dialog Stylus via
Start > Settings > Control Panel.

In the register Double-Tap you may use the grid pattern to preset a double
click velocity and test this on the symbol below. OK takes over the set
value. The calibration of the touch screens happens via the register
Calibration by following the instructions.

Set Ethernet parameters

The dialog field for pre-setting an Ethernet address is to be found at
Start > Settings > Network and Dial-up Connections.

The default setting is address assignment via DHCP.

System properties (System)

Here you receive information about the version of the current Windows®
operating system, the memory load and sharing (alterations here are not
taken over into the registry) and about the copyright.

The register Device Name allows you to change the device name that is
e.g. shown during Ethernet communication.

Note!

All alterations made here are cleared after PowerOFF-PowerON. To store
them permanently into the registry file you have to store them explicitly. For
this, call “Save Registry” at Start > Programs > KuK Tools. Use [OK] to
store the data in the registry file.

2-16
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Communication via ActiveSync

Overview ActiveSync is a communication platform developed by Microsoft especially
for mobile computers to synchronize data between a mobile device and a
PC via USB res. Ethernet. Many developer tools res. SCADA project-
engineering tools use ActiveSync for the data transfer.

Before you may access the Touch Panel from the PC via ActiveSync you
have to install it at the PC.

ActiveSync is freeware and may be downloaded from www.microsoft.de.

Installation * Download the ActiveSync from the Microsoft website and start the file
MSASYNC.EXE.

The following dialog window appears:

Microsoft ActiveSync

Set Up Microsoft® ActiveSync® 3.8
Before pou can exchange information between your mobile
device and this computer, you must set up ActiveSyne.
Thiz zetup wizard will guide you through:
Installing the ActiveSync program on this computer
Setting up your mobile device
Mate: It iz strongly recommended that pou exit all Windows

pragrams befare cantinuing with this setup wizard.

Click Mest to continue with the setup process. Click Cancel
ta quit zetup.

Cancel Help

» Start the installation with [Next].

* Choose an installation directory and click on [Next].
- ActiveSync is installed.

Establish After the installation the dialog window "establish connection" is opened. If
connection your Touch Panel shall be available via Ethernet you have to install a point-
to-point connection first.

» Start the search run with [Next]:

Get Connected x|
Checking COM Ports .i,
Pleaze wai while Setup locates pour mobile device, V

Progr

Looking for a mobile device...
Checking on COM Port 1
Checking USB

< Back Hest s M Eancel Help
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Install partnership Now you may install a "partnership” via an USB connection with the
for USB communi- following approach:
cation + Connect your Touch Panel via the "Device"-USB-B jack with your PC

and turn on the Touch Panel. -~ The USB device (Touch Panel) is
recognized and the dialog window "new partnership" opens.

Mew Partnership x|

Set Up a Partnership
3
1

E Before you can synchronize information between pour
mobile device and this computer, vou must set up a
partnership between them.

“wiould you like to zet up a partnership?

!et up a partnership so that | can spnchronize

information between my device and this computer.
i Mo

| don't want to synchronize information. Set up my
device az a guest 2o that | can copy or mave
information between my device and this computer.

< Back I Mext > I Cancel | Help |

* Choose "yes" that you want to fix a partnership and push [Next].

» In the now opening window, de-activate all synchronization settings and
click on [Next]:
x|

Select Synchronization Settings =
Select the type of information you want to synchionize. @

To synchronize a particular tppe of information, select itz check box. To stop
synchronization of that information, clear ite check box.

Mobile Device | Desktop Computer |
B Mot Installed

Charnel 5Spnchronization
Mat Installed
Synchronized Files
Microzoft Outlook

1§ Packet Access Microzoft D atabases
Tazks Mot Installed

Tofind out more about and to customize what gets synchronized, click Settings... |
oh that infarmation type in the list and then click Settings. =

Calendar

< Back I Mest > I Cancel | Help |

» [Finish] establishes the partnership.

Now you may access the Touch Panel with ActiveSync via USB.

Note!

To keep the settings also after power on, you have to store them to the
registry with START > Programs > KuK Tools > Save Registry.
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Install partnership Please regard, Ethernet communication is only supported by ActiveSync up
via Ethernet to Version 3.8.
If your Touch Panel shall be available via Ethernet you have to install a
partnership for USB communication first like shown above. Afterwards you
may configure a partnership for Ethernet communication after the following
approach:

* To enable the Touch Panel to be accessed via Ethernet you have to
activate the option "enable network connection” in ActiveSync via
File > Connection Settings:

Connection Settings ﬂ

Q Click Get Connected to connect pour mobile device to thiz

i@ camputer,

Statuz: Device connected [Fet Connected... |

v Allow zerial cable or infrared connection to this COM port:

fcam1 [~

Statuz:  COM port iz not available

v Allow USE connection with this desktop computer.

Statuz:  Connected

@Iaw network, [Ethernet] and Remote Accesz Service [RAS)

erver connection with thiz dezktop computer.

Statuz:  Metwork connections are dizabled

Statuz icon
’7 v Shaw status jcon in Taskbar.

(1] 4 I Cancel Help

» Disconnect the USB cable of the Touch Panel.
» Confirm the message that the device could not be found.

o Start the communication program required for ActiveSync at the Touch
Panel via START > Programs > Communication > Act.Sync Netw and
click on [Connect].

Now you may access the Touch Panel with ActiveSync via Ethernet.

Note!

To keep the settings also after power on, you have to store them to the
registry with START > Programs > KuK Tools > Save.
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Integrated Server

Login data

Change password

The Touch Panel has several integrated server that enable a remote
maintenance within a network. Some servers only allow access by means
of entering User name and Password. Per default the following login data
are used:

User name: wince
Password: vipatp

You must not change the user name. But you may change the password
via the registry.

For this, start the editor via START > Programs > Registry Editor. The
entry for the password is to be found at:
HKEY_LOCAL_MACHINE/KUKINIT/DefaultPasswd

Please remember to store the changes to the registry via START >
Programs > KuK Tools before switching off.

Overview Per default the following server are integrated:

» ftp server (activated)
* http server (activated)
» Telnet (activated)

* VNC (not activated)

Phrases Phrases that are used in the description of the server:

Client A client is an application that uses the service of a server within a network.
For example, a web browser is a client because at every call of a website it
sends a request to a web server and receives an answer.

Server A server is an application that waits for the contact request of a client
application and exchanges messages with it after contact start. This
communication type is called Client-Server communication.

Host Computer within a network where at least one server is running.

Download Data transfer Server — Client

Upload Data transfer Client - Server

2-20 HB160E - TP - RE_612-3B2J0 - Rev. 10/16



Manual VIPA HMI

Chapter 2 Deployment Touch Panel

ftp server

Conditions for
ftp access

Internet Explorer

Netscape

By means of an ftp server data between client and server can be
exchanged. Here you may copy, delete or create files and directories.

For in the meanwhile an ftp client (Internet Explorer) is integrated in
Windows®, this is the easiest method for remote maintenance of the Touch

Panel.

Depending on the ftp client your PC has to fulfill the following conditions for
an ftp connection. If there are still problems with the ftp access ask your

system administrator.

» ftp access possible with version 5.5 or higher
* use passive ftp mode
» activate directory view for ftp sites

For the adjustment choose in the Internet Explorer Options > Internet
options, register "extended" in the area "Browsing” and set the following

settings:

- activate: "activate directory view for ftp sites"

- activate: "use passive ftp..."

The settings are taken over when re-starting the Internet Explorer.

Internet Opkions e |
Generall Seu:urityl F'rivac:yl Eontentl Cunnectionxl Pragrams Advanced
Settings:
Browszing ;I
Ahways zend URLs az UTF-8 [requires restart)
[ Automatically check for Internet Explorer updates
Close unused folders in History and Favarites (requires restart]
Dizable zcript debuaaing

[ Display a notification about every script erar

Enable falder view for FTF sites

Show Go button in Address bar
Show Internet Explarer on the desktop
Underline links
O Always
O Hover
=5 Mewver
O Use inline AutoComplete
sive FTP [for firewall 2

rd DSL modem |::|:|I'|'|!:|.E||.i|:|i|it_','] -
b
Bestore Defaults |

0k I Cancel | Apply |

» Ftp access only possible with version 6.0 or higher, you need no further

settings.
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Establishing a In the following the establishing of an ftp connection between a Windows®
ftp connection based PC (here Windows® 2000) with Internet Explorer as ftp client and
your Touch Panel is shown.

e Connect your Touch Panel with the network where your PC is a member
via an Ethernet cable.

» Switch on your Touch Panel.
As soon as your Touch Panel is connected via Ethernet, you may monitor

the IP address data via ‘ﬂ-‘“.
=15

IP Information |

Internet Protocol (TCP/IP)
Address Type: DHCR

1P Address:

Subnet Mask: 205.255,224.0
Default Gateway: 172,16,128.4

Renew

&start || windows |[omsce

L EEY 20:01 @

» After you've confirmed the pre-settings, start your ftp client and enter the
following text into the "address bar":

o« ftp://w nce:vipat p@ P- Adresse

The following window appears:

B3 ftp://172.16.135.22/ - Microsoft Internet Explorer _ |8 x|
Ele Edt Wew Favortes Ioos bel |
dmback - = v (2] | @isearch ChFoders (B |08 U X = | B~
Address [[80 frpifj172.16.135.22] B ‘Llnks ”|
L ek IJ Name_* [ seefType [ Modified |
[ Application Data File Folder 11/23(2005 10:50 AWM
i (CIFtashdisk File Folder 1/1/1998 1:00 PM
172.16.135.22 Camy Dacuments Fils Folder 11/23[2005 11:50 &AM

CInetwork File Folder 1/1/1998 1:00 PM
Server: 172.16.135.22 Cprofiles File Folder 11/23[2005 11:50 AWM
User hame: wince ClProgram Files File Folder 11/23/2005 11:50 &AM
Cdrecycled File Folder 11/23[2005 10:50 AM
Temp File Folder 11/23[2005 11:50 AM
Click hiere ko lsarn sbout browsing FTP [ ] windaws File Folder 11232005 11:50 AM
sites. ] Control Panel.ink 23bytes  Shartcut 11/23/2005 11:50 AM

Here you may execute the wanted file operations.
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http server

Web admin

Sys admin

Functions

The Touch Panel has an integrated http server (web server) that allows
depending on the access the administration of the Touch Panel res. of
websites in the Touch Panel. The administrative access to the http server
happens via Ethernet from the PC by setting the IP address of the Touch
Panel with attached "Admin" type.

By means of websites you may e.g. publish online documentations for a
connected PC or go online with applications at the PC.

As web admin you have access to all functions that are required for
uploading and administrating of websites at the Touch Panel. Additionally
you may set the access rights for user and create user groups. More
detailed information about creating and administrating of websites at the
Touch Panel is to be found in the online documentation of the web servers.

The login as web admin requires the following steps:

» Start the web browser at your PC and enter the following into the
address bar: | P addr ess/ webadm n

» Enter the following into the authentification:
User name: wince
Password:  vipatp

Remember to store your changes permanently in the registry via Start
> Programs > KuK Tools > Save Registry!

Sys admin provides you with system administration rights for the
administration of the Touch Panel. Here you may see system information
and may administrate files, processes and registry entries.

The login as sys admin requires the following steps:

» Start the web browser at your PC and enter the following into the
address bar: | P addr ess/ sysadni n

» Enter the following into the authentification:
User name: admin
Password:  vipatp

As sys admin you have access to the following functions:

Group Area Description

System Tools | System Info | System information about hardware,
memory sharing and date/time.

Processes | Shows all running processes. Via "Kill"
these can be terminated singularly res. be
started with the field "Launch process".

File Browser Drives File manager that offers all relevant
functions for administration of files and
directories.

Registry Editor | Registry key | Registry editor for deleting, altering and
creating of registry entries.

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 2-23




Chapter 2 Deployment Touch Panel Manual VIPA HMI

Telnet server Telnet is a text based client-server protocol on TCP level. By means of a
Telnet client like e.g. the "MS-DOS console" in your Windows® operating
system you may execute text based all file remote functions at your Touch
Panel like copy, delete and create files and directories. You may also start
applications. Terminating an application is not possible.

Establishing a The establishing of a Telnet connection is password protected and has the
Telnet connection  following approach:

» Start a Telnet client like for example "MS-DOS console" at your PC and
enter the following into the address bar:
telnet | P address
When the connection is established, the Touch Panel asks for the user
name and the password.

% |[Eingabeaufforderung - telnet 172.16.135.22 | o [ |
Welcome to the Windows CE Telnet Service on VIPATP ﬂ
login:

» Enter the following:
Login: wince
Password:  vipatp (entry is hidden)

After entering valid user data a command line for entries appears:

+|Eingabeaufforderung - telnet 172.16.135.22 | o ] 4|
elcome to the Windows CE Telnet Service on UIPATP 3

login: wince
assword:

gcket CMD v 5.8

||

By entering Exi t res. closing the window you may terminate the Telnet
connection at any time.
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Commands

% |Eingabeaufforderung - telnet 172.16.135.22 =10 x|

Eucket CHD v 5.8 il

> help

ATTRIB
CALL
cDh
CHDIR
CLS
copy
DATE
DEL
DIR
ECHO
ERASE
EXIT
HELFP
GOTO

REN
REMAME
RMDIR
SET
SHIFT
START
TIME
TITLE
TYPE

A

The following commands are available:

llze HELP [command namel to display extended help for given command, op
HELF CHD to display help on general topics such as
command input optionz,. -0 redirection or CHD parameters.

After establishment of a Telnet connection the Touch Panel provides you
with commands. A list of possible commands with a short description is
available via the command hel p.

By beginning with "help" before a command you receive help to this
command.

Setsdisplay file attributes.

Call bhatch script.

Change directory.

Same as CD.

Clear the =creen.

Copy files.

Dizplayszet szystem date.

Delete a file.

Print contents of a directory.

Echo output on the szcreen or change echoing parameters.
Same as DEL.

Exit command interpreter.

Print help for command interpreter or individual commands.
Transfer control to a labhel in hatch processing.
Conditionally execute a command.

Create a directory.

Same as MD.

Movesrename files.

Alias for SET PATH.

Suszpend execution of a hatch file.

Reconfigure system prompt.

Print current working directory.

Remove directory.

Record comments in batch file.

Change file name.

Same as HEM.

Same as RD.

Set opr list environment variahles.

Shift arguments of a batch file.

Start detached process.

Displayschange system time.

Set the window title for a CHD.EHE szession.
Output contents of a file or files to the screen.
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VNC server

Establishing a
VNC connection

The Touch Panel has an integrated VNC server (virtual network control)
that allows the total control of the Touch Panel with a PC via network. For
this, a window displays the current Touch Panel content for remote control.
The operating happens via PC keyboard and mouse. Using VNC the
context menu functions are available via the right mouse button.
Condition for the VNC communication is that the VNC server is started at
the Touch Panel and a VNC client at the PC. You may download a VNC
client as Freeware from Internet.

Note!

Since with the VNC server all safety attitudes can be gone around, you
should use these exclusively for start-up! For this reason the VNC server is
on delivery deactivated.

The VNC connection establishment has the following approach:

* Click onk & and open the "Windows" directory.

* You have to deactivate every option at View > Options to show the VNC
server file.

» Start the VNC server by executing the file KUKVncSVR.exe. To show

the server has been started the symbol LE’J appears in the task bar.
You may also start the VNC server at the Touch Panel via a Telnet
connection by entering the command kukvncsvr in the command
console with an active Telnet connection.

» Now start the VNC client vncviewer.exe at your PC.

* Click on [Options] and de-activate the field "Emulate 3 Buttons..." like
shown at Mouse.

x
j [].4 |
Cancel |

RE  wiccener [i7216152

Uze host: display
2.0, $noopy: 2
[Dizplay defaults to Oif not given)

Conneckion Options...

— Preferred encoding —Mouze

% Heutile ( u }'mulate 3 Buttons [with 2-button click

" CoRRE [ Swap mouse buttons 2 and 3
® r Display
" Faw

[ Restrict pixels to &bt (for slaw networks]

v &llow CopyRect encading I™" Wiew only (inputs ignared)

[ Fullscreen mode

— Mizc [ Scale by |1_ ! |1_ [experimental]

[ Fequest shared session
DK I

[ Deiconify on Bell
[~ Disable clipboard transfer
» Enter the IP address of the Touch Panel at VNC server. With [OK] a
VNC connection is established and the screen content of the Touch
Panel is monitored within a window.
Closing the VNC window terminates the VNC connection, the server keeps
running.

Cancel |
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Access to the network resources

Overview

List released
resources

Connect net drive

Example:

The Touch Panel allows you to access shared resources in a Microsoft
network like drives and printer. Here you may assign existing public
directories or printer in the network to local directories or printer in the
Touch Panel.

Condition for this is that you login at the network with your user name and
password.

The assignment of a network resource happens in the Touch Panel via the
command console "Command Prompt". Start the command console with
START > Programs > Command Prompt.

The access to the network resource happens with the commands Net view
and Net use.

Shared resources of a network PC can be listed with the command: \> net
vi ew PC- Nane

For example net view testserver lists all shared resources of the
network PC "test server". To test the physical connection a PING to the IP
address of the network PC may be executed if there are problems while
contacting the network PC.

\'> net view testserver
Shared resources on \\testserver:

Shar e nane Type Used as Comment

Ar chive Di sk (null) Process data

Ky oEDV Print (null) Kyocera FS-680 Printer
Conmand conpl et ed successful ly

\> ]

The connection of a local name at the Touch Panel with a shared drive of
the network PC happens with the following approach:

» Enter the following in the command prompt:
\> net use local _name \\network drive /user:User nane

» Enter user name, password and where app. user group.

After the successful login the following message appeatrs:
Successfully mapped to network nane.

The connected network drive is then available at the Touch Panel with the
local name via My Device at Network.

Local_Name: data, network drive: testserver\archive, User name:gast

Entry: \> net use data \\testserver\archive /user: gast

The connected network drive is then available via \network\data at the
Touch Panel.
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Configure network
printer

Test print

List network
connections

Terminate network
connections

The configuration of a network printer happens with the following approach:

» Enter the following into the command prompt:
\> net use printer name network printer

Example:

Printer name: Printer, network printer: \\testserver\printer
Entry:\>net use printer \\testserver\printer

» Enter user name, password and where app. user group.

After the successful login the following message appears
Successfully mapped to network printer

The printer may now be accessed as "network\printer".
For example you may print the content of the current directory with \> di r

> network\ printer.

The listing of all network connections of your Touch Panel happens via
\>net use

\> net use
Connect ed resources:

St at us Local Nane Renot e Nanme

Connect ed dat a \\testserver\archiv
Connect ed printer \\testserver\printer
Conmand conpl et ed successful ly

\> ]

You may terminate already assigned network resources via
\>net use | ocal _nane /d

Example: \> net use data /d deletes the network connection to the
drive "archive" of "test server".

Note!

To keep the settings also after power on, you have to store them to the
registry with START > Programs > KuK Tools > Save Registry.
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Integration to WLAN network

Overview By plugging a WLAN card there is the possibility to integrate your Touch
Panel to a WLAN network. For this driver for the corresponding WLAN
hardware are pre-installed.

WLAN via Please regard only SDIO WLAN cards are supported which drivers are pre-
SDIO card installed in the Touch Panel. In the Touch Panel driver exist for the
following SDIO cards:

e Socketcom P300
* Spectec SDW821
e JustMobile Wireless LAN Card.

Installation  PowerON the Touch Panel.

* Plug the SDIO card - the SDIO card is identified and a dialog window,
which shows the available WLAN networks, is opened.

e Continue with "WLAN integration".

WLAN via Please regard only WLAN-USB sticks are supported with the chip of the
USB stick company Funkwerk inside!
Installation » PowerOFF the Touch Panel.

* Plug the WLAN USB stick to the USB-A interface.
» PowerON the Touch Panel - the driver name is requested.
» Enter "prisma02" - now your card is installed and activated.

Note!

To keep the settings also after PowerON, you have to store them to the
registry with START > Programs > KuK Tools > Save Registry.

WLAN integration Directly after installation a dialog window is shown. Here the available
WLAN networks are displayed.

Chose the corresponding network and click to [Connect].

At a safety-relevant network set the network parameters and enter the
network key. If the parameters are correct the connection is established.
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Automatically
connect to WLAN

If the Touch Panel should connect automatically to your WLAN network
after startup, so the automatically connection is to be activated.

For this open the register "Wireless Information” in the dialog window and
click to the [Advanced...] button.

MT59111 m H
IP Information | Wireless Information I

Select a network and press connect or right-click for more
options. To add a new network, double-click "add New'.

< hpsetup
§ VIPATPWL (preferred)
i V-TW-02-speed?

Status: Connected to VIPATPWL
Signal Strength:  Very Good

[V Notify me when new wireless ne are available

Connect I ‘&dva ed....l ‘View Lug...l

The following window is shown:

Advanced Wireless Settings m

[V] Use Windows to configure my wireless settings

windows will connect to the following networks
whenever they are available. Preference wil be given
to networks at the top of this list.

Preferred Networks
§ VIPATPWL Up

Down

Delete

Automatically connect to non-preferred networks

Networks to access: I'&" available EI

‘ Ok I Cancell

By activating of "Automatically connect to non-preferred networks" an
automatically connection to the chosen network is established as soon as
the network is available.

Please do not forget to store the settings with the KuK Tools as shown
above.
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Firmware update

Overview You may execute a firmware update via SD or CF card. The newest
firmware version may be ordered by the VIPA Panel Support.

Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the Touch Panel, for example if the
voltage supply is interrupted during transfer or if the firmware file is
defective. In this case, please call the VIPA Panel Support!
Please regard that the firmware to be transferred is not checked by the
Touch Panel. Always use the firmware, which you received for exactly this
Touch Panel from our Panel Support.

Proceeding *  For new firmware contact the VIPA Panel Support. They will send you
the appropriate firmware as zip file via mail.

* Unzip the zip file and store it at your PC.

»  Copy the unzipped files into the root directory of your memory card. As
memory card a SD or CF card may be used.

*  Switch off the power supply from your panel. Plug the memory card to
your panel and switch on the power supply again. - As soon as a new
firmware is found at the memory card, it is downloaded to the Touch
Panel and the message "Update please wait" is displayed. If the
update is finished (after max. 5min.) "Update finished" is displayed.

e Switch off the Power supply from your Panel. Remove the memory
card and switch on the power supply again. Now the Touch Panel
starts up with the new firmware.

If there is no message "Update finished" displayed after maximally 15
minutes or the Touch Panel does not start-up after firmware update, you
should contact the VIPA Panel Support.

Note!

Please regard depending upon the used version the Touch Panel may be
adjusted again!

Adjustments The following adjustments could be necessary:
* New calibration of the touch screen

 Depending on the visualization software the license key may be re-
entered. More may be found in the documentation of the visualization
software.

Do not forget to store the settings durably with the KuK Tools. For this go

to Start > Programs > KuK Tool > KuK Tool and store the settings with
[Store].
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Chapter 3

Overview

Content

Installation Guidelines

The chapter "Installation Guidelines" gives you information about the
interference-immune installation of Programmable Logic Controls (PLC)
together with a Touch Panel.

Here we describe possible paths in which interference can enter the
controller, how you ensure the electromagnetic compatibility (EMC) and
how to approach shielding and screening issues.

Topic Page
Chapter 3 Installation Guidelines........cccccoeiiiiiiiiiiiiiiie e, 3-1
Basic rules for the EMC-equitable assembly of installations................. 3-2
EMC-equitable assembly....... ... 3-6
EMC-equitable cabling ..........oouuiiiiiiiieece e 3-7
Special precautions providing high noise immunity ..............cccccevvnnee 3-11
Checklist for the EMC-compliant installation of controllers ................. 3-12
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Basic rules for the EMC-equitable assembly of installations

What is EMC?

Possible sources
for disturbances

The term electromagnetic compatibility (EMC) refers to the ability of an
electrical device to operate properly in an electromagnetic environment
without interference from the environment or without the device causing
illegal interference to the environment.

The Operation Panels are developed for applications in harsh industrial
environments and complies with EMC requirements to a large degree. In
spite of this you should implement an EMC strategy before installing any
components, which should include any possible source of interference.

Electromagnetic interference can enter your system in many different ways:

Fields

=

Automation .
< Bus > System < I/O-Signal >
T ©

Power PE

Interference is coupled into your system in different ways, depending in the
propagation medium (conducted or not conducted) and the distance to the
interference source.

We differentiate between:

» galvanic coupling

e capacitate coupling

* inductive coupling

» radiated power coupling

3-2
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Coupling
mechanisms and
interference
sources

The following table shows the four different coupling mechanisms, their
causes and possible interference sources.

Coupling mechanism

Cause

Typical source

Galvanic coupling

Disruptor

¢ galvanic

coupling line

Automation
System

Galvanic or metallic coupling
always occurs when two
current circuits have a
common line.

Pulsed devices
(Net influence from

transducers and foreign net

devices)
Starting motors

Different potential of
component cubicles with
common current supply

Static discharges

Capacitate coupling

Disruptor

capacitive
coupling line

Automation
System

Capacitate or electric coupling
occurs between conductors
with different potential.

The coupling is proportionate
to the time wise change of the
voltage.

Interference through parallel

signal lines

Static discharge of the
personnel

Contactors

Inductive coupling

Disruptor

)

inductive

<—— coupling

line

wanted signal

Automation
System

Inductive or magnetic coupling
occurs between two current
active line loops.

The magnetic flows associated
with the currents induct
interference voltages.

The coupling is proportional to
the time related change of the
current.

Transducers, motors,
electric welding devices

Parallel net cables

Cables with toggled currents

Signal cable with high
frequency

Unused coils

Radiate power coupling
Disruptor

radiated

Automation
System

One talks of radiate power
coupling, when an electro-
magnetic wave meets a line
circuit.

The hit of the wave inducts
currents and voltages.

Sender in the neighborhood

(e.g. walkie-talkie)
Sparking lines

(sparking plugs, collector of

electric motors, welding
devices)
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Basic rules for
ensuring EMC

In many cases, adherence to a set of very elementary rules is sufficient to
ensure EMC. For this reason we wish to advise you to heed the following
rules:

During the installation of your automation units you should ensure
that any inactive metal components are grounded via a proper large-
surface earth!

» Interconnect any inactive metal components via low-impedance
conductors with a large cross-sectional area.

» Execute screw connections at coated and anodized metal parts either
with special contact washer or remove the isolating protective film.

e Install a central connection between the chassis ground and the
earthing/protection system.

Ensure that cabling is routed properly during installation!

» Divide the cabling into different cable groups
(High voltage lines, power supply lines, signal lines, data lines).

* Always install high voltage lines and signal or data lines in separate
channels or bundles.

» Install signal and data lines as close as possible to any metallic ground
surfaces (e.g. frames, metal rails, sheet metal).

Ensure that the screening of lines is grounded properly!

« Data lines must be screened. The screen has to be laid both-sided.

* Analog lines must be screened. Where low-amplitude signals are
transferred it may be advisable to connect the screen on one side of the
cable only.

» Attach the screening of cables to the ground rail by means of large-
surface connectors located as close as possible to the point of entry.
Clamp cables mechanically by means of cable clamps. Route the
connected screen to the modules without interruptions, but don't
connect the screen again.

* Ensure that the ground rail has a low-impedance connection to the
cabinet/cubicle.

» Use only metallic or metallic covers for the plugs of screened data lines.

3-4
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In critical cases you should implement special EMC measures!

« Connect snubber networks to all inductive loads that are not controlled
by special EMC modules.

* Use incandescent lamps for illumination purposes inside cabinets or
cubicles, do not use of fluorescent lamps.

Create a single reference potential and ensure that all electrical
equipment is grounded wherever possible!

* Ensure that grounding measures are implemented effectively. The
controllers are earthend to provide protection and for functional reasons.

* Provide a star-shaped connection between the plant, cabinets/cubicles
and the grounding/ protection system. In this way you can avoid ground
loops.

* Where potential differences exist you must install sufficiently large
equipotent bonding conductors between the different parts of the plant.
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EMC-equitable assembly

Guidelines for
assembling and
grounding of
inactive metal
parts

Mostly, measures for suppressing interference voltages are only taken,
when the control is already in commission and the perfect receive of a
wanted signal is disturbed.

Causes for such interference's are in the most cases inadequate reference
potentials, coming from mistakes at the device assembly and installation.

When assembling the devices, you have to ensure the large-surface
grounding of the inactive metal parts. A correctly done grounding supports
an unambiguous reference potential for the control and reduces the impact
of coupled interference's.

Grounding means the conducting connection of all inactive metal parts.
The sum of all interconnected inactive parts is called Ground.

Inactive parts are all conductive parts electrically separated from all active
parts by means of a basic isolation and that may only get voltage in case of
an error.

The ground must not adopt dangerous contact voltage even in case of an
error. Thus you have to connect the ground with the protected earth
conductor. To avoid ground loops, local distant ground constructions
(cubicles, construction and machine parts) have to be connected with the
protected earth conductor system in star-topology.

Please regard at grounding:
» Connect the inactive metal parts as carefully as the active ones.

» Take care of impedance-low metal-metal-connections, for e.g. with
large-surface and well conductive contacts.

* If you include coated or anodized metal parts in the grounding, you have
to come through the isolating protection layers. For this you may use
special contact washers or remove the isolation layer.

» Protect the connection points from corrosion, e.g. with grease.

* Moveable grounding parts (e.g. cubicle doors) have to be connected via
flexible ground strips. The ground strips should be short and have a
large surface, because the surface is decisive for the diversion of high
frequency interference's.
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EMC-equitable cabling

Line routing

Line routing inside
and outside of
cubicles

Content of this section is the line routing of bus, signal and supply lines.
Object of the line routing is to suppress the "slurring” at parallel lines.

For an EMC-equitable routing of the lines it is convenient to divide the
cables in different groups and install each group itself:

Group A

» screened bus and data lines

» screened analog lines

» unshielded lines for direct voltage < 60V

» unshielded lines for alternating voltage < 25V
» Coaxial cables for monitors

Group B
» unshielded lines for direct voltage >60V and <400V
» unshielded lines for alternating voltage >25V and <400V

Group C
» unshielded lines for direct and alternating voltage >400V

Group D
» Lines for H1 respectively TCP/IP
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Combination of
groups

Line routing
outside of
buildings

Lightning
protection

Following the table you may see the conditions for the cabling of the line

groups by combining the single groups:

Group A

Group B

Group C

Group D

Group A

[1]

[2]

[3]

[4]

Group B

[2]

[1]

[3]

[4]

Group C

[3]

[3]

[1]

[4]

Group D

[4]

[4]

[4]

[1]

[1] | The lines may be installed in common bundles or cable trusses.

[2] |The lines have to be installed in different bundles or cable trusses
(without min. distance).

[3] |The lines have to be installed in different bundles or cable trusses
inside of cubicles and outside of the cubicle but inside the building
in separated cable trusses with a min. distance of 10cm.

[4] | The lines have to be installed in different bundles or cable trusses
with a min. distance of 50cm.

Wherever possible, exterior cabling should be installed on metallic cable
trays. A galvanic connection must be provided for joints between cable
trays.

You must abide by the applicable lightning protection and grounding
regulations when installing exterior cables.

Attention!

Where cables and signal lines for PLC equipment are installed outside of
buildings, the conditions for internal and external lightning protection must
be satisfied.

» Exterior lines should either be installed in metallic conduit pipes that is
grounded on both ends or in steel-reinforced concrete cable trunks with
continuously connected reinforcing.

» Signal lines should be protected against overvoltage by varistors or by
lightning arrester filled with rare gas.

» Install these protective elements at the location where the cables enter
the building.

Note!

Any lightning protection system must be based on an individual
assessment of the entire plant. For questions please contact VIPA GmbH.

3-8

HB160E - TP - RE_612-3B2J0 - Rev. 10/16




Manual VIPA HMI

Chapter 3 Installation Guidelines

Equipotential
bonding

Rules for
equipotential
bonding

Screening of lines
and cables

Potential differences can occur between different sections when controllers
and peripheral equipment are connected by means of non-isolated
connections or the screens of screened cables are connected at both ends
and grounded on different sections of the plant.

One reason for a potential difference can be that different sections of the
plant are powered from different power sources. These potential
differences must be reduced by means of equipotential bonding conductors
to ensure that the electronic equipment employed on the plant operates

properly.

» The lower the impedance of the equipotential bonding conductor, the
higher the effectiveness of potential equalization.

* The impedance of the equipotential bonding conductor must not exceed
10% of the impedance of the screen where screened signal lines are
connected between the different sections of the plant and the screening
is connected to ground/neutral on both sides.

» The cross-sectional area of the equipotential bonding conductor must be
calculated to carry the maximum equalization current. The following
cross-sections have been successfully employed:

- 16mm? Cu for equipotential bonding conductors up to 200m
- 25mm? Cu for equipotential bonding conductors exceeding 200m.

» Use copper or galvanized steel for equipotential bonding conductors.
These must be connected to ground/neutral by means of large-surface
connections that are protected from corrosion.

» The equipotential bonding conductor should be installed in such a
manner that it includes the smallest surface between the bonding
conductor and the signal lines.

Screening is one method commonly used to reduce (attenuate) the
interference pick-up from magnetic, electrical or electromagnetic fields.

» Interference on screens is conducted to ground by the conductive
connection between the screen and the screening rain/enclosure. To
avoid interference from these currents it is very important that the
neutral connection is a low-impedance connection.

* You should only use of cables that are provided with a braided screen.
The degree of screening should be more than 80%.

* Avoid cables with foil-type screens as the foil is easily damaged by
tension and pressure at the point of attachment; this can result in
reduced effectiveness of the screening action.

» As a rule you should always ground the screens of cables on both ends.
This is the only way in which you can ensure that high frequency
interference is attenuated properly.
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One-sided
grounding of
screens

Connecting the
screen

In exceptional cases it may be necessary to ground the screen on one side
only. However, this will only attenuate the lowest frequencies. The one-
sided grounding of screens may provide advantages when:

* Itis not possible to install an equipotential bonding conductor
* Analogue signals (a few mV or pA) must be transmitted
» Foil-type screening (static screening) is employed.

You should always use metallic or metallic covers for serial data lines.
Connect the screen of the data line to the cover. Do not connect the
screen to PIN 1 of the connector!

In case of stationary operations it is recommended that the remove the
insulation from the screened cable without cutting the screen and to attach
this point to the screening/neutral rail.

Note!

Potential differences can give rise to an equalization current via the screen
connected between the two ground connections.

In this case you must install an additional equipotential bonding conductor.

Please observe the following points when you handle the screens:

* Use only metallic cable clamps when connecting the screening of
cables. These clamps must provide a good electrical contact and a
large-surface connection to the screen.

» Attach the screens to the screening rail directly at the point where the
cables enter the enclosure.
The screening conductor must be continued to the module without
interruption, however, it must not be connected to the module!

i
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Special precautions providing high noise immunity

Inductors require
snubber networks

Equipotential
bonding

Power outlet for
PGs

Cubicle
illumination

Suppression of
fluorescent lamps
in cubicles

Inductors controlled by your programmable controller (e.g. contactors and
relays) do not normally require additional snubber networks or suppressors
as the respective modules have been provided with the required
components.

Snubber networks must only be connected to inductors when output
circuits can be disabled by means of additional contacts (e.g. relay
contacts). In this case the integrated suppressors on the module are also
disabled.

You can connect diodes to suppress back-emc, varistors or RC-networks
to the inductors.

Connections of Connections of
DC-activated inductors AC-activated inductors
using a diode using a Z-diode using a varistor using RC-network

e L S—
1 = VAN ] L]
— —

Every cubicle must be provided with a power outlet for the PU. These
outlets must be wired to the distribution system, which is also used to
connect the neutral conductor for the cubicle.

The cubicle illumination should consist of incandescent lights, e.g.
LINESTRA-lamps. Avoid using fluorescent lamps as these lamps can
cause interference.

If you can not avoid using fluorescent lamps you should implement the
steps outlined in the following figure.

1 2 [1] Fluorescent lamp

I w [2] Screen above the lamp

of [3] Screened cable

5 [4] Switch with metallic cover

[5] Line filter or screened power
cable

HB160E - TP - RE_612-3B2J0 - Rev. 10/16 3-11



Chapter 3 Installation Guidelines Manual VIPA HMI

Checklist for the EMC-compliant installation of controllers

EMV-measures Space for Notes

Connection of the inactive parts
You should take special care to check the connections of:
¢ Module racks

* Frames
« Screen and protected earth conductor

Are all the inactive metal parts interconnected by means of
large-surface and low-impedance connections?

Has a proper connection been installed with respect to the
ground/protected earth conductor system?

Has the isolation been removed from varnished and anodized
surfaces or have these connections been fitted with special
contact washer?

Have the connection been protected from corrosion, e.g. by
means of grease?

Have doors been grounded by means of grounding straps
connected to the body of the cubicle?

Cable routing

Cabling divided into groups?

Power cables (230 ... 400V) and signal lines installed in
separate channels or bunches?

Potential compensating

When installing the equipment at separate locations, check
the installation of the potential compensating line.

Cable screen
All covers of plugs are metallic?

All analog and data lines installed screened?

Line screens attached to the screening or the protected earth
conductor?

Have the screens been connected by means of large-surface
and low-impedance cable clamps?

Cable screens grounded both-sided where possible?

Inductors

Have the coils of contactors controlled by means of contacts
been connected to snubber networks?
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